UMIK-2
OMNI-DIRECTIONAL MEASUREMENT MICROPHONE

User Manual
## Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>Preliminary</td>
<td>17 August 2020</td>
</tr>
<tr>
<td>0.2</td>
<td>Updated</td>
<td>21 August 2020</td>
</tr>
<tr>
<td>1.0</td>
<td>Public release</td>
<td>17 September 2020</td>
</tr>
<tr>
<td>1.1</td>
<td>Added more REW info</td>
<td>30 November 2020</td>
</tr>
<tr>
<td>1.2</td>
<td>Added firmware update procedure</td>
<td>2 December 2020</td>
</tr>
<tr>
<td>1.3</td>
<td>Correction to driver download</td>
<td>3 December 2020</td>
</tr>
</tbody>
</table>
# Table of Contents

Important Information ........................................................................................................... 4

1. Product overview ............................................................................................................. 6

2. Installation and Configuration – Windows ......................................................................... 7
   2.1. Download ...................................................................................................................... 7
   2.2. USB driver installation ................................................................................................. 7
   2.3. Control Panel ............................................................................................................... 8
   2.4. UAC2 Control Panel .................................................................................................... 9

3. Installation and Configuration – Mac OS X ....................................................................... 11
   3.1. Download ...................................................................................................................... 11
   3.2. Configuration in Audio MIDI Setup ............................................................................ 12

4. Download the Calibration Files ....................................................................................... 13

5. Microphone Positioning and Orientation ......................................................................... 14
   5.1. Free-field measurement ............................................................................................... 14
   5.2. In-room measurement for speakers ............................................................................ 14
   5.3. In-room measurement for subwoofers ....................................................................... 15

6. Using the UMIK-2 with Dirac Live .................................................................................. 16

7. Using the UMIK-2 with Room EQ Wizard ........................................................................ 17
   7.1. Set device sample rates ............................................................................................... 17
   7.1.1. What sample rate should I use? ................................................................................ 17
   7.1.2. Windows .................................................................................................................. 18
   7.1.3. macOS ..................................................................................................................... 19
   7.2. Initial REW configuration ............................................................................................ 20
   7.3. Configuring ASIO (Windows only) ............................................................................ 22

8. Additional information ...................................................................................................... 24
   8.1. Specifications ............................................................................................................... 24
   8.2. Firmware upgrade ...................................................................................................... 25
   8.2.1. Windows ................................................................................................................. 25
   8.2.2. macOS .................................................................................................................... 27
   8.3. Obtaining support ....................................................................................................... 29
IMPORTANT INFORMATION

Please read the following information before use. In case of any questions, please contact miniDSP via the support portal at support.minidsp.com.

Disclaimer/Warning
miniDSP cannot be held responsible for any damage that may result from the improper use or incorrect configuration of this product. Please read this manual carefully to ensure that you fully understand how to operate and use this product, as incorrect use or use beyond the parameters and ways recommended in this manual have the potential to cause damage to your audio system.

Please also note that many of the questions we receive at the technical support department are already answered in this User Manual and in the online application notes on the miniDSP.com website. So please take the time to carefully read this user manual and the online technical documentation. Thank you for your understanding!

Warranty Terms
miniDSP Ltd warrants this product to be free from defects in materials and workmanship for a period of one year from the invoice date. Our warranty does not cover failure of the product due to incorrect connection or installation, improper or undocumented use, unauthorized servicing, modification or alteration of the unit in any way, or any usage outside of that recommended in this manual. If in doubt, contact miniDSP prior to use.

FCC Class B Statement
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

- This device may not cause harmful interference.
- This device must accept any interference received, including interference that may cause undesired operation.

Warning: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Notice: Shielded interface cable must be used in order to comply with emission limits.

Notice: Changes or modification not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.
CE Mark Statement

The UMIK-2 has passed the test performed according to European Standard EN 55022 Class B.

A Note on this Manual

This User Manual is designed for reading in both print and on the computer. If printing the manual, please print double-sided. The embedded page size is 8 ½” x 11”. Printing on A4 paper will result in a slightly reduced size.

For reading on the computer, we have included hyperlinked cross-references throughout the manual. In addition, a table of contents is embedded in the PDF file. Displaying this table of contents will make navigation much easier:

- In Adobe Reader on Windows, click on the “bookmarks” icon at the left. The table of contents will appear on the left and can be unfolded at each level by clicking on the “+” icons.
- In Preview on the Mac, click on the View menu and select Table of Contents. The table of contents will appear on the left and can be unfolded at each level by clicking on the triangle icons.
1 PRODUCT OVERVIEW

Thank you for purchasing a miniDSP UMIK-2 omni-directional USB measurement microphone. The UMIK-2 features a low-noise ½-inch microphone capsule, low-noise A/D converter, and support for sample rates from 44.1 to 192 kHz.

Each UMIK-2 has a unique calibration file for measurement accuracy. A generated 90-degree calibration file is also provided for multichannel/surround-sound applications.

The UMIK-2 has driverless operation with macOS, Linux, Android and iOS. A supplied ASIO driver for Windows ensures simple integration into many measurement and recording applications. The UMIK-2 is of course fully compatible with Room EQ Wizard (REW) and Dirac Live (version 3 and later). Many other applications are also perfectly suited to the UMIK-2:

- Speaker measurement and design
- Room corrections
- Acoustical measurement and characterization
2 INSTALLATION AND CONFIGURATION – WINDOWS

For use with Windows, the miniDSP driver must be installed. You will also need to download the software package if there is a firmware upgrade.

2.1 DOWNLOAD

The UMIK-2 drivers and firmware can be downloaded from the User Downloads section of the miniDSP website. You will need to be logged into the website to access the download.

The User Downloads link is visible from the dropdown menu at the top right of the website page:

Navigate to the UMIK Series / AmbiMIK Series section, click on UMIK-2, then click on the download link at the right. Unzip the downloaded file by right-clicking on it and selecting “Extract All...”.

2.2 USB DRIVER INSTALLATION

The USB driver enables Windows to stream audio to the UMIK-2. In addition, it installs a control panel to help manage the UMIK-2.

To install the driver, go to the WinDrivers folder of the installation download and double-click on the installer:

- miniDSP_UAC2_v4.82.0_2020-06-09_setup.exe

(The version number embedded in the filename may be different.)

We recommend accepting the default installation location. Once the driver installation completes, click the Finish button.
2.3 **CONTROL PANEL**

In Windows 10, open the Control Panel, then go to Hardware and Sound, then Manage Audio Devices. Here you can set the UMIK-2 as the default audio input device, and set its sample rate and bit depth (click on the Properties button).

![Control Panel screenshot](image)

Note that many recording and measurement programs will set the sample rate themselves, overriding the setting made manually in the Control Panel.
2.4 UAC2 CONTROL PANEL

Open the miniDSP UAC2 Control Panel (from Start Menu -> miniDSP Ltd). It has several tabs.

Status

This tab shows the current sample rate of the UMIK-2. This setting cannot be changed in the Control panel, but simply reflects the current sample rate of the UMIK-2.

Format

This tab shows the input channel bit depths:
Volume
This tab provides adjustment of input gain. Note that some recording and measurement software, including DiracLive and Room EQ Wizard, will set the input level automatically.

Info
This tab shows information about the UMIK-2.
3 INSTALLATION AND CONFIGURATION – MAC OS X

Mac OS X / macOS has native support for USB Audio class 2.0 devices, so no driver installation is required. You will need to download the software package should you need to update the UMIK-2 firmware.

3.1 DOWNLOAD

The UMIK-2 firmware can be downloaded from the User Downloads section of the miniDSP website. You will need to be logged into the website to access the download.

The User Downloads link is visible from the dropdown menu at the top right of the website page:

Navigate to the UMIK Series / AmbiMIK Series section, click on UMIK-2, then click on the download link at the right. Unzip the downloaded file by double-clicking on it.
3.2 Configuration in Audio MIDI Setup

Open the program Audio MIDI Setup (in Applications->Utilities). Click on the device UMIK-2 that appears in the list on the left. This will display the input and output channels. The Format drop-down menu will show the supported sample rates:

![Audio Devices](image)

Note that many recording and measurement programs will set the sample rate themselves, overriding the setting made manually in Audio MIDI Setup.
4 Download the Calibration Files

The calibration files are used to correct the raw microphone response for measurement accuracy. Two calibration files are provided: an on-axis calibration file measured from the actual microphone, and a 90-degree calibration file that is calculated from the on-axis response. One of these calibration files will need to be loaded into the acoustic measurement software you are using. (See later pages for an example with REW.)

To download the calibration files, go to the UMIK-2 product page and scroll down to the section “Unique Calibration File Download”. Enter your microphone’s serial number and press Submit.

The two calibration files should download automatically. They will be named 800xxxx.txt and 800xxxx_90deg.txt (where 800-xxxx is your microphone’s serial number). If they don’t download automatically, click on the links shown on the page to download them:

Don’t lose your serial number! We have had customers who, after a number of years, have rubbed off the serial number label and lost their calibration files (e.g. a computer crash). We don’t keep a record of the serial number sent to every customer, so we recommend that you a. make a hard copy of your serial number and b. add your calibration files to your regular computer backups, just in case.
5 MICROPHONE POSITIONING AND ORIENTATION

Acoustic measurements are typically one of two types: in-room and free-field.

5.1 FREE-FIELD MEASUREMENT

Free-field measurements are commonly used for measuring and designing speakers. For this type of measurement, always point the microphone directly at the sound source and use the normal (0-degree) calibration file.

For this purpose, the sound received by the microphone would ideally be free of any reflections – that is, only the direct sound from the speaker being measured without any reflections of influence from the room. In practice, free-field measurements of a speaker often have to be done in a room, so various techniques are used to remove or mitigate the effect of the room. For more information, see our app note Loudspeaker measurement with UMIK-1 and REW.

5.2 IN-ROOM MEASUREMENT FOR SPEAKERS

In-room measurements are used to measure the combined effect of a speaker (or subwoofer) and the room in which it’s located. The sound measured by the microphone consists of the direct sound from the speaker and the sound caused in the room by reflections and resonance (modes).

For measurements of this kind, the microphone is typically placed at and around the center of the listening area. If the goal is to capture the signal from the speaker most accurately with the effects of the room added, point the microphone towards the speaker and use the normal (0 degree) calibration file.
If the goal is to try and capture as much of the room as possible, point the microphone towards the ceiling and use the 90-degree calibration file. If there are multiple speakers, such as in a multichannel/surround system, then always use the 90-degree orientation to ensure consistent measurement between speakers.

Bear in mind that in-room measurements do not have an absolute ideal reference in the same way that free-field measurements do. The preferred response can vary depending on the nature of the speakers and the room. Therefore, at high frequencies (above 5 kHz) adjustment of EQ or target curve by ear is likely to be needed anyway.

For more information, see our app note Acoustic measurement with the UMIK-1 and REW.

5.3 IN-ROOM MEASUREMENT FOR SUBWOOFERS

For measuring subwoofers, the orientation of the microphone or choice of calibration file doesn’t matter. This is because the two calibration files differ only above a few kHz, due to the high-frequency directionality of the microphone.

For more information and guides on measuring and tuning subwoofers, see the app notes in the Home Theater Tuning section of our app note library.
6 USING THE UMIK-2 WITH DIRAC LIVE

The UMIK-2 is fully compatible with Dirac Live (version 3 or later). The UMIK-1 and UMIK-2 are the only microphones supported by miniDSP for use with its Dirac-Live enabled processors.

1. Install the software for your processor as instructed by your product’s user manual.
2. Connect the microphone to the computer. Figure 1 illustrates a typical setup.
3. Follow the procedure in the miniDSP Dirac Live User Manual to load the calibration file and perform measurements.

Figure 1. Typical measurement setup for Dirac Live
7 USING THE UMIK-2 WITH ROOM EQ WIZARD

If you do not already have Room EQ Wizard (REW) installed, download it from roomeqwizard.com. Download the latest beta version for UMIK-2 support. Figure 2 illustrates an example measurement setup.

![Diagram of a typical measurement setup for REW]

**Figure 2. Typical measurement setup for REW**

7.1 SET DEVICE SAMPLE RATES

It is important that the input and output device sample rates configured in the operating system are the same as the sample rate set in REW. If they are not the same, the operating system will do a sample rate conversion on the input or output data, which in some cases can lead to incorrect results.

Note: this step is not necessary if you use ASIO drivers in Windows. However, it does not hurt to do it.

REW may give incorrect readings if the sample rate set in REW does not match the sample rate set in the operating system. Double-check this each time you start REW.

7.1.1 What sample rate should I use?

For general purpose speaker and acoustic measurement, 48 kHz is a good choice. This will give you a measured response past the limit of human hearing (20 kHz).

If you need to measure higher – to measure the ultrasonic performance of a tweeter, for example – use a higher sample rate such as 96 kHz. Be aware however that the UMIK-2 calibration file only goes up to 20 kHz. Measurements above 20 kHz can be used for comparison purposes but for accurate ultrasonic measurements you will need to obtain or generate a custom calibration file.
7.1.2 Windows

Open Control Panel, then Hardware and Sound, then Manage Audio Devices. On the Playback tab, click on the output device and then Properties. Drop down the selector to set the sample rate.

Go to the Recording tab and click on the UMIK-2 and then Properties. Drop down the selector to set the sample rate.
7.1.3 macOS

Open the Audio MIDI Setup application. Click on the output device in the left sidebar and drop down the Format menu to set its sample rate.

Click on the UMIK-2 in the left sidebar and drop down the Format menu to set its sample rate.
7.2 **INITIAL REW CONFIGURATION**

1. If you have not already done so, plug the UMIK-2 into your computer and set sample rates as described on previous pages.

2. Start REW. You will see a dialog such as the following. Click on Yes.

![MiniDSP UMIK-2 detected dialog](image)

3. You will then see a dialog such as the following. Click on Yes.

![Checking for calibration file dialog](image)

4. Navigate to the calibration file in your file system and select it. Choose the on-axis or 90-degree file according to the type of measurement you are doing.

![Mic calibration files dialog](image)
5. Open REW Preferences (spanner icon at top right). Confirm that the UMIK-2 is selected for input. Here you can also select the output device.

6. Click on the Cal Files tab and confirm that the calibration file is loaded for the UMIK-2. It should be selected for the MICROPHONE device as shown below.

If you wish, you can select it for the top input shown as well. This corresponds to the “Default” input selection.
7.3 CONFIGURING ASIO (WINDOWS ONLY)

If you need to output audio via ASIO, you will need to use ASIO4ALL. First download it from https://www.asio4all.org/ and install it. Then, in the REW Preferences window:

1. Select ASIO under **Drivers** at the top left of the window.
2. Select ASIO4ALL as the ASIO Device.
3. Click on the ASIO Control Panel button. Click on the wrench/spanner icon at the lower right to enable advanced mode. Then select the desired input and output devices from the list on the left. Disable unused devices. In this example, we are using the miniDSP SHD as the output device and the UMIK-2 as the input device:

![ASIO Control Panel](image)

Note that there are two entries for the SHD as it has both input and output channels. Hover your mouse over them to see which is which, and enable just the output channels.

4. Close the ASIO Control Panel. On REW Preferences, select the desired output and input channels. Note that the Input dropdown will show two channels – it doesn’t matter which one you select. This screenshot shows a completed I/O configuration:
5. When you select the UMIK-2 for input, the dialog asking you if you want to use the UMIK-2 for calibration will again appear:

![miniDSP UMIK-2 detected dialog]

6. Click Yes, and select the calibration file to be used for ASIO4ALL:

![Calibration data window]

7. Click on the Cal Files tab and verify that the calibration file is shown for ASIO4ALL:

![ASIO4ALL v2 calibration file]

---

miniDSP Ltd, Hong Kong / www.minidsp.com / Features and specifications subject to change without prior notice
8  ADDITIONAL INFORMATION

8.1  SPECIFICATIONS

USB Audio Controller
XMOS 500MHz multicore processor, USB Audio Class 2 (UAC2)

ADC
32-bit, 120 dB SNR
1/2” Low noise Pre-polarized condenser on 60UNS thread
Sensitivity: -31.9 dB FS (94 dB SPL. 1 kHz)

Capsules
Noise level: -105.3dBfs (A) @ 0 dB gain
MAX SPL(0dBfs): 125dB SPL
Equivalent Input Noise (EIN): 20dB SPL @ 0dB gain

Connectivity
USB 2.0 streaming, USB 2.0, Type C connector
Selectable sample rate 44.1 to 192 kHz
As a standard USB audio microphone, UMIK-2 is compatible with any software.
However we recommend the following proven platforms with plug-and-play integration.
- Room EQ Wizard freeware for acoustic measurements
- Dirac Live Room Correction platforms

Software
Linux/macOS/Android Driverless
ASIO compatible driver for Windows
iOS support with USB camera adaptor
1 x mini tripod with microphone clamp

Accessories
1 x windscreen
1 x 2-meter USB cable

Dimensions (W x D), weight
21 x 185 mm, 150g

Construction
Aluminum body
8.2 **FIRMWARE UPGRADE**

miniDSP may occasionally provide an upgrade to the UMIK-2 firmware. To upgrade the firmware, first download the latest version of the UMIK-2 software package from the User Downloads section of the miniDSP website, then extract it on your computer (on Windows, right-click and select “Extract All...”; on Mac, double-click).

**DO NOT DISCONNECT THE USB CABLE OR POWER FROM THE PROCESSOR WHILE FIRMWARE UPGRADE IS IN PROGRESS. DOING SO MAY “BRICK” YOUR PROCESSOR.**

Double check that there are no other miniDSP devices are connected to your computer when performing the firmware upgrade. Having another device connected while performing the UMIK-2 firmware upgrade could damage the device.

8.2.1 **Windows**

1. Connect the UMIK-2 to your computer via USB (if not already connected).

   - If there is any other miniDSP device connected to your computer, disconnect it now.

2. Navigate to the XMOS_Firmware\Firmware_Upgrade_Tools\Windows\miniDSPUAC2Dfu folder of the software download.

3. Double-click on miniDSPUAC2Dfu.exe to run it. The application will start:

   ![USB Audio Device Firmware Upgrade](image)

   - Device
     - Manufacturer: miniDSP
     - Product: UMIK-2
     - VID/PID: 0x2752/0x002B
     - Serial number: 00000
     - Current Firmware: v2.03

   - Firmware
     - [Browse...]

   - Upgrade
     - Device opened.

   - [Start]

   - [Exit]
4. Click on the **Browse** button and select the firmware file from the **XMOS_Firmware** folder of the software download. It will have a name like “UMIK-2_v2.3.bin.” (The version number “v2.3” may change.)

5. Click on the **Start** button.

6. You will get a progress bar as the upgrade proceeds:

![Upgrade Progress Bar](image)

7. Once the firmware upgrade completes, you will see a message that the upgrade completed successfully:

![Upgrade Message](image)

8. Click on **Exit**.

9. That’s it! You’re done.
8.2.2 macOS

1. Connect the UMIK-2 to your computer via USB (if not already connected).

⚠️ If there is any other miniDSP device connected to your computer, disconnect it now.

2. Navigate to the XMOS_Firmware/Firmware_Upgrade_Tools/Mac folder of the software download.
3. Double-click on the .zip file to extract the firmware update software, then double-click on miniDSP USB DFU.app to run it. The app will start:
4. Click on the **Browse** button and select the firmware file from the **XMOS_Firmware** folder of the software download. It will have a name like “UMIK-2_v2.3.bin.” (The version number “v2.3” may change.)

5. Click on the **Start** button.

6. You will get a progress bar as the upgrade proceeds:

![Upgrade Progress Bar](image)

7. Once the firmware upgrade completes, you will see a message that the upgrade completed successfully:

![Upgrade Completed](image)

8. Click on **Exit**.

9. That’s it! You’re done.
8.3 OBTAINING SUPPORT

1. Check the forums on miniDSP.com to see if this issue has already been raised and a solution or solutions provided.

2. Contact miniDSP via the support portal at support.minidsp.com with:
   a. The product information.
   b. A clear explanation of the symptoms you are seeing.
   c. A description of the troubleshooting steps you performed and the results obtained.